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1 Introduction 
 
 
1.1 Provider Electronic Solutions Overview 
EDS’ Provider Electronic Solutions program is designed to provide the billing provider 
with a faster and more efficient method of transaction submission and processing. 
Handling time and errors are reduced, eliminating delays in processing and decreasing 
turnaround times. 
 
Provider Electronic Solutions is a transaction entry software package developed by EDS 
that meets the standards implemented by HIPAA. The software allows for electronic 
transaction submission directly to the Northeast Regional HIPAA Translator. 
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2 System Set-Up 
 
 
2.1 Equipment Requirements 
Provider Electronic Solutions is designed to operate on a personal computer system with 
the following equipment requirements: 
 

Minimum Recommended 
Windows 98/2000/XP Windows 2000 or Windows NT or higher 
64 Megabytes RAM 128 Megabytes RAM 
800 X 600 Resolution 1024 X 768 Resolution 
9600 Baud Rate Modem or faster 9600 Baud Rate Modem or faster 
WinZip WinZip 
 
2.1.1 Provider Electronic Solutions Software Media 
The Provider Electronic Solutions application programs and files are located on EDS’ 
web site at www.vtmedicaid.com.  Click on Downloads and then click on Software to 
access the appropriate web page. 
 
2.1.2 Program Installation 
The Provider Electronic Solutions application was designed for installation on the PC 
hard drive or to a network.  To simplify installation, an automatic installation program is 
included in the download.  Your computer must have WinZip in order to install the 
software.  The instructions are as follows: 
 
 
Step 1.  Access the web site listed above and click on Downloads and then click on 

Software.  Click on Provider Electronic Solutions.  A screen similar to the 
following File Download screen will be displayed: 
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Figure 1.  File Download screen 
 
Step 2.  Click on the Open button and the file will be saved to a temporary file on your 

PC.  When the following screen is displayed, double click on the file titled 
“VT_V02xx_setup.exe”.  This will begin the install and automatically proceed 
through the process. 

 

 
Figure 2.  WinZip screen 
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Step 3.  Select Next at the Welcome screen. See Figure 3 
 

 
Figure 3.  Welcome Screen 
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Step 4.  At the Setup Type screen, highlight TYPICAL or WORKSTATION and select 
the Next button. Most installations will be a typical installation. See Figures 4a 
and 4b for details. 

 

 
Figure 4a.  Setup Type screen showing the description of a Typical setup. 
 
The Typical installation installs all of the files, including the database.  This installation is used to 
install to a stand-alone PC, or initially to a network server. 
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Figure 4b.  Setup Type screen showing the description of a Workstation setup. 
 
The Workstation installation is used for all additional PCs that are connected to a network server 
where all users share the database.  The initial installation of Typical to a PC has been completed 
as noted above.  This installation type does not load the database files to the PC; however, it does 
allow for sharing the database files that were installed to the network. 
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Step 5.  At the Choose Destination Location screen, see Figure 5, select Next to install to 
the default directory, C:\vthipaa.  If the software on the PC is to run from a network 
rather than the PC hard drive, select the appropriate destination drive. 
 

 
Figure 5.  Choose Destination Location screen 
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Step 6.  At the Choose Database Destination Location screen, see Figure 6, select Next to 

load the database in the default directory, C:\vthipaa, or select the appropriate 
destination drive for installing to a network. 

 

 
Figure 6.  Choose Database Destination Location Screen. 
 
 
Step 7.  At the Information screen, select OK, see Figure 7.  As stated on this screen, 

note the drive and directory where the files were installed.  The system will then 
install the program files. 

 

 
Figure 7.  Information screen. 
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Step 8.  At the InstallShield Wizard Complete screen, select Finish to complete the 

setup. See Figure 8. 
 

 
Figure 8.  InstallShield Wizard Complete screen. 
 
There will be an application folder placed on your desktop titled VT EDS Provider 
Electronic Solutions.  At this time, you may close the WinZip window. 
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3 Basic Skills 
 
 
3.1 Signing On 
To access the Provider Electronic Solutions application: 
 
 
Step 1.  Double click the application folder from the desktop and then select EDS 

Provider Electronic Solutions, or 
 
 
Step 2.  Select the Start button in the bottom left-hand corner of the PC, then select the 

Program option and then select “VT EDS Provider Electronic Solutions” and 
then “VT EDS Provider Electronic Solutions”. 

 
 
Step 3.  Once the option is selected, the Logon screen appears. The default User ID is 

“pes-admin” and the default password is “eds-pes”. 
 
Note:  The first time you log on you will be prompted to change the password.  If this is 
your first log on, proceed to Step 4. 
 

 
Figure 9.  Logon screen 
 
 
Step 4.  Select OK. 
 

 
Figure 10.  Password Expired dialog box. 
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Step 5.  Enter the old password and then enter a new password twice.  The software has a 
feature to allow for password reset beginning with version 2.14.  Click on the 
drop down arrow on the Question field and select one of the questions listed.  
Enter the appropriate answer in the Answer and Rekey Answer fields.  Select 
OK.  A dialog box displays a message stating whether or not the update was 
successful. 

 

 
Figure 11.  Logon screen showing the Change Password fields. 
 
 
Step 6.  Select OK if the update was successful. 
 

 
Figure 12.  Logon Status dialog box 
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Step 7.  If this is your first logon, the system will display the message shown in Figure 

13.  Select OK to update personal options.  The Options dialog box will display. 
 

 
Figure 13.  Application dialog box showing login status. 
 
 
Step 8.  Select the Batch tab.  This information is necessary for connecting with the web 

site for uploading and downloading files.  All fields are required, however, only 
one Communication Number and Qualifier is needed.  Please note that the Web 
User ID is the same as your Trading Partner number. 

 
Note:  In addition, the password below must match the password you created on the 

web site. 
 

 
Figure 14.  Options dialog box showing the Batch tab. 
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Step 9.  Select the Web tab.  This is pre-set to use the Internet Explorer Settings on your 

PC.  You will need to change the Environment Ind to A for submitting an 
acceptance test.  Once you receive confirmation from EDS that the test was 
successful, you will need to change the Environment Ind to P. 

 

 
Figure 15.  Options dialog box showing the Web tab. 
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Step 10.  Select the Modem Tab.  If your PC has a modem, select the Detect button on 

the Modem tab.  If the modem is not automatically detected, find the modem 
information by selecting the Start button from the bottom left corner of the 
desktop screen.  Then select Settings and Control Panel.  Depending on the 
version of Windows the next option is either Modems or Phone and Modem 
Options. 

 
The Modem Tab must be completed even if no modem is present on the PC.  In this case, 
place the cursor in the Modem Type field to access the modem listing.  Select Generic 
Configuration, for most modems. 
 
 

 
Figure 16.  Options dialog box showing the Modem tab. 
 
 
Step 11.  Select the Interactive tab.  Verify that the Modem Init String field is populated 

from the modem type selected on the Modem tab 
 

 
Figure 17.  Options dialog box showing the Interactive tab. 
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Step 12.  Select the Carrier tab.  This information is necessary for the submission of the 
transactions.  Choose the transaction type by selecting it at the bottom of the 
screen.  It will highlight in blue.  Using the drop down arrow, select the carrier 
type with a phone number appropriate for your area.  If there is not a local 
number available, select one of the toll-free numbers.  Update the DTR 
(modem speed) to the appropriate speed to match your modem.  You will need 
to set the X12 Production/Test Indicator to T for submitting a test.  Once you 
receive confirmation from EDS that the test was successful, you will need to 
change the indicator to P. 

 
Transaction Type Interactive is used for Eligibility Verification and Claim Status Request 
when you want an immediate response.  Transaction Type Batch Transmit is used for 
submitting claims. 
 

 
Figure 18.  Options dialog box showing the Carrier tab. 
 
 
Step 13.  Select the Retention tab. This tab lists options for file storage and archiving. 
 

 
Figure 19.  Options dialog box showing the Retention tab. 
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Note:  The Payer/Processor tab has been completed for you. No entry or change is 
necessary to the information on this tab. See Figure 18. 
 
 

 
Figure 20.  Options dialog box showing the Payer/Processor tab. 
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3.2 Using the Software 
Now that all the necessary information to submit your transactions has been entered, you 
may begin using the software.  This application appearance has been designed based on 
Windows. Each of the options at the top of the screen has the standard Windows options.  
The software has been enhanced to allow users to review each option through the Help 
feature. 
 
3.2.1 Main Menu 
The icons under the menu titles represent each of the forms that may be submitted.  Each 
of them is listed at the end of this section.  You may also select Forms from the tool bar 
to select your form. 
 

 
Figure 21. Provider Electronic Solutions Main Menu 
 
From the menu you may select any of the options. They include the following: 
 
• File 
 
• Forms 
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• Communication 
 
• Lists 
 
• Reports 
 
• Tools 
 
• Security Maintenance 
 
• Window 
 
 
File 
 
The File menu item exits the application. You may also select the X box in the upper 
right hand corner of the screen. 
 

 
Figure 22.  Main Menu showing the File menu item. 
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Forms 
The Forms menu item allows you to open any of the transactions for entry. These are the 
same as the icons listed on the second line of the menu bar. 
 

 
Figure 23.  Main Menu showing the Forms menu items. 
 
 
Communication 
 
The Communication menu item allows for the following: 
 
• Submission transmits transactions to the Northeast Regional HIPAA Translator. 
 
• Resubmission resubmits a batch or copies the claims from a batch for editing and 

submitting. 
 
• View Batch Response allows viewing of downloaded responses to Eligibility 

Verification and Claim Status requests. 
 
• View 835 ERA allows viewing of the weekly Remittance Advice in an electronic 

format. 
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• View Accept/Reject Claim Report – Functional Acknowledgement allows viewing of 
the EDS created report listing claims or files that were unable to be loaded into the 
system. 

 
• It also displays the Communication Log, which indicates the claim batch number and 

submission details. 
 

 
Figure 24.  Main Menu showing the Communication menu items. 
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Lists 
 
The Lists menu item allows you to select from the available lists to enter or edit the 
information.  The lists are described further in Section 5. 
 

 
Figure 25. Main Menu showing the Lists menu items. 
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Reports 
 
The Reports file menu item allows the printing of detail and summary reports for 
transactions and the contents of lists.  Detail and summary reports may be printed for all 
the transactions.  You may select one or more of the selection criteria to narrow the 
transactions to be printed. 
 

 
Figure 26. Main Menu showing the Reports menu items. 
 
 
Tools 
 
The Tools file menu item allows for the following: 
 
• Archive allows you to archive old transactions or restore transactions that were 

previously archived. (see Section 8) 
 
• Database recovery allows the user to compact, repair and unlock the database. 
 
• Get Upgrades allows you to dial into the web site to check for and download 

upgrades to the software.  See Section 9 for instructions on downloading upgrades. 
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• Change password allows users to change their passwords. 
 
• For Options, refer to Section 3 – Basic Skills Signing On. 
 

 
Figure 27.  Main Menu showing the Tools menu items. 
 



VERMONT TITLE XIX 
PROVIDER ELECTRONIC SOLUTIONS SOFTWARE 

USERS GUIDE 

 - 25 - 

 
Security 
 
The Security file menu item allows administrators to enter, update and remove users, 
their passwords and authorization levels 
 

 
Figure 28.  Main Menu showing the Security menu item. 
 
Each user should be assigned their own User ID and password.  To add a new user: 
 
Step 1.  Select Security and then Security Maintenance from the Menu Bar. 
 
Step 2.  Assign a User ID unique to the individual. 
 
Step 3.  Enter an initial password.  The user will be required to change their password 

when they log into the system for the first time. 
 
Step 4.  Enter the Authorization Level.  A user with an Authorization Level of 2 User 

(Non Administrator) is allowed to enter, transmit, and download transactions 
and files.  An Authorization Level of 3 Administrator is allowed the same 
security as a User, and is also allowed to enter, modify, or delete User IDs.  The 
Security option will not appear on the menu of a person that is assigned the 
authorization level of 2. 
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Figure 29. Assigning a security authorization level 
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Window 
 
The Window file menu item allows you to arrange the screens displayed. 
 

 
Figure 30. Main Menu showing the Window menu items. 
 
The Help function is described in Section 4. 
 
3.2.2 Menu Options 
From the menu you may select any of the icons.  The icons shown below represent each 
of the transaction types that are currently functional.  To access the transaction, click on 
the appropriate icon or select Forms from the toolbar. 
 

 
270 Eligibility Request 
 

 
276 Claim Status Request 
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837 Dental 
 

 
837 Institutional – Home Health 
 

 
837 Institutional - Inpatient 
 

 
837 Institutional - Nursing Home 
 

 
837 Institutional – Outpatient 
 

 
837 Professional 
 
Placing the mouse pointer on the icon displays the name. 
 
Before you may begin entering transactions, several lists must be completed.  This may 
be done now, or as you key in your transactions.  There are four lists that should be used 
and completed prior to finishing a transaction: Provider,  Client, Other Provider, and 
Taxonomy Code. 
 
• The Provider list maintains the provider’s information by Medicaid Provider Number. 
 
• The Client list maintains the client information by Vermont Medicaid Client 

Identification Number. 
 
• The Other Provider list maintains the provider’s information by Medicaid Provider 

Number. 
 
• The Taxonomy Code List represents the provider type, classification, area of 

specialization and training and education indicator.  A list of taxonomy codes is 
available from the Washington Publishing Company at http://www.wpc-
edi.com/codes/  

 
Because of certain requirements of the ANSI ASC X12 transactions, the software is 
designed to require the entry of the lists for Provider and Client.  Entering the information 
on the individual transaction is no longer required and size of the transactions screens is 
kept to a minimum. 
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4 Help Function 
 
 
4.1 Using Help 
The help option works the same as most Windows-based help features.  If you select 
Help from the menu outside of a transaction you are taken to the Help Welcome screen. 
 
 

 
Figure 31.  Main Menu showing the Help menu items. 
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By clicking on Contents and Index  F1,  the Welcome screen appears. 
 

 
Figure 32.  Help menu welcome screen. 
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You may select the Help Topics button.  You will be taken to a screen with three (3) tabs.  
The first tab is Contents.  By double clicking on EDS Provider Electronic Solutions 
listing, it will open the contents page.  Make a selection to view the contents. 
 

 
Figure 33.  Help dialog box showing the Contents tab. 
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The second tab is Index.  You may enter text into field 1, and the system will find the 
closest match to your request.  You may also use the scroll bar on the right of the list in 
field 2 to locate your option. 
 

 
Figure 34.  Help dialog box showing the Index tab. 
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The third tab is Find.  This option opens the Find Setup Wizard to allow for searches on 
specific words and phrases. 
 

 
Figure 35.  Find Setup Wizard displays after selecting the Find tab. 
 
 
The last option of the help screen is to select the Help button from inside a transaction.  
Position your cursor in a field and select the Help button (F1) and you will be taken to the 
Help topic for that field. 
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5 Lists 
 
 
5.1 List Functions 
The list function has been added to the software for two reasons.  First, it allows a 
provider to enter information that is frequently used and then access this information in a 
transaction using a Drop Down Data Window (DDDW) and second, it reduces the size of 
the transaction screens by requiring certain information to be entered into a list. 
 
There are many data elements included in the software that are required to generate a 
HIPAA compliant format.  This is especially true of provider and client information.  As 
a result, the Provider Electronic Solutions software requires that these lists be entered 
prior to completing a transaction.  Additional lists include procedure code, diagnosis 
code, revenue center code and place of service. 
 
There are two lists that have been populated with data.  They are Carrier, which lists the 
codes and names of other insurance companies and the Place of Service list.  Both of 
these lists may be updated to add, delete or change the information to better serve your 
office.  Please be aware that the codes listed are standard codes and may not be changed 
without notice resulting from HIPAA or EDS updates. 
 
The lists may be accessed from the Main Menu by selecting the List option or by double 
clicking in the appropriate field.  This option allows a provider to add the information, as 
they need it, rather than requiring that all information be entered prior to keying a 
transaction. 
 
Once the information has been keyed into the list, it is available from the DDDW to 
populate the fields.  Although not all of the information from the list will appear on the 
transaction screen, it will be used when formatting the HIPAA transaction prior to 
submission. 
 
Lists may be sorted by the row headers.  In Figure 36, the client list is sorted by selecting 
the Client ID, Last Name or First Name heading.  Selecting the header one time will sort 
in ascending order.  Selecting twice will sort in descending order.  Upon opening, the 
Client and Provider lists are sorted by the ID number. 
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Figure 36. Client list sorted by selecting the Client ID, Last Name or First Name heading 
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6 Data Entry 
 
 
Select a transaction from the Menu Bar.  Each transaction has different fields and 
requirements.  If you are not sure of a field, select the Save button.  Any required fields 
will display as errors. 
 
6.1 System Edits 
This software has been designed with edits that assist in completing a transaction 
properly.  The system reports any errors resulting from these edits once the Save button 
has been selected.  In order to submit a transaction, all errors must be resolved.  If there 
are no major errors, the transaction may be saved in an incomplete status.  This retains 
the information keyed, but does not transmit the transaction until the error(s) is corrected. 
 
To correct an error, double click on the error listed in the Error Message box.  The field 
containing the error is then displayed.  Repeat this process until all errors have been 
corrected.  See Figure 37. 
 

 
Figure 37. Sample error screen 
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For specific information regarding a field, please refer to the Help option on the Menu 
Bar or hit F1 after placing the cursor in the field. 
 
6.2 Other Insurance and Medicare Crossovers 
 
Providers may submit claims electronically when the primary payer has made a payment.  
You may also submit approved claims that did not cross over directly from Medicare.  If 
the claim was denied by the primary payer, including Medicare, you must submit on 
paper with a copy of the Explanation of Benefits. 
 
All other insurance payments must be reported at the service (detail) level in addition to 
the total paid amount reported in the header. 
 
Enter Y in the Other Insurance Ind field.  This field is contained on the last HDR tab of 
each claim form. The screen examples below are from the 837 Professional claim form. 
 

 
Figure 38. HDR screen showing Other Insurance Indicator 
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Once you have changed the Other Insurance Ind to Y, there will be an OI tab and an OI 
ADJ tab included in the claim.  These two tabs will be used to enter the insurance 
information as well as the total payment received and are identical on all claim forms. 
 

 
Figure 39. OI Tab screen 
 



VERMONT TITLE XIX 
PROVIDER ELECTRONIC SOLUTIONS SOFTWARE 

USERS GUIDE 

 - 39 - 

 
Figure 40. OI Adj Tab screen 
 
The OI and OI ADJ screens apply to the entire claim and the Paid Amount on the OI ADJ 
screen must be equal to the sum of the Paid Amounts on the SRV ADJ screens. 
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Double click on the Carrier Code field on the OI Tab to enter the required Policy Holder 
information.  The following screen will appear and must be completed in order to save 
your claim. 
 

 
Figure 41. Policy Holder screen 
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To enter the information at the service level, you will need to enter Y in the Service 
Adjustment Ind field on each service billed.  This field is contained on the SRV 2 screen 
for Dental claims, SRV 1 screen for Professional claims, and SRV screen for all 
Institutional claims. 
 

 
Figure 42. SRV screen showing Service Adjustment Indicator 
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Once you have changed the Service Adjustment Ind to Y, there will be a SRV ADJ tab 
included in the claim.  This tab will be used to enter the insurance information for the 
service being entered. 
 

 
Figure 43. Srv Adj Tab screen 
 
 
 
Note:  For claims to process as a cross over from Medicare, the claim must contain the 
correct information as follows: 
 
• Claim Filing Ind Code on the OI Tab must be MA if the service is covered as a 

Medicare Part A service and MB if a Part B service. 
 
• Carrier Code on the Policy Holder list must be MDA for Medicare A and MDB for 

Medicare B. 
 
• The Adjustment Reason Code on the OI Adj tab must be 1 for deductible and 2 for 

coinsurance with the corresponding amounts entered in the Adjustment Amount field.  
For Medicare B claims, you must also enter information at the detail level by entering 
Y in the Insurance Adjustment Ind field.  This will add the SRV ADJ tab.  This 
screen is similar to the OI ADJ screen and must be completed for each service billed. 
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6.3 Electronic Replacement/Void Claims 
 
Previously paid claims can be adjusted using the Replacement Claim transaction by 
entering the Claim Frequency Code 7 and recouped using the Void Claim transaction by 
entering the Claim Frequency Code 8. 
 
For dental and professional claims, the Claim Frequency Code can be found on HDR 1.  
For all institutional claims, the Claim Frequency Code is the third digit of the Type of 
Bill.  When a Claim Frequency Code 7 or 8 is entered, you must enter the ICN of the 
claim being replaced or voided. 
 
NOTE:  When submitting a Replacement Claim, you must enter all details 
contained on the original claim. 
 
6.4 Eligibility and Claim Status Requests 
 
Eligibility verification and Claim Status requests can be completed either as a batch or 
interactive transaction.  The interactive transaction returns the response to a single 
request within a few seconds.  The batch transaction allows for submission of multiple 
requests in one transaction and the response may be retrieved the following processing 
day. 
 
6.4.1 Eligibility Request 
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Figure 44. Eligibility Request screen 
 
Both batch and interactive eligibility requests are completed on the Eligibility Request 
screen shown above.  To submit an interactive request, complete the required fields and 
click on the Send button.  To submit a batch of requests, complete the required fields and 
click on the Save button for each request.  Once all of the requests have been entered, 
follow the instructions for submitting Files under section 7.1. 
 
6.4.2 Claim Status Request 
Both batch and interactive claim status requests are completed on the Claim Status 
Request screen shown below.  To submit an interactive request, complete the required 
fields and click on the Send button.  To submit a batch of requests, complete the required 
fields and click on the Save button for each request.  Once all of the requests have been 
entered, follow the instructions for submitting Files under section 7.1. 
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Figure 45. Claim Status Request screen 
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7 Submitting/Receiving Transactions 
 
 
Submitting and Receiving transactions are accomplished using the Communication menu 
item.  Select Submission regardless of whether you want to submit or receive files. 
 

 
Figure 46. Communication menu screen 
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7.1 Submitting Files 
Select the type(s) of file to submit under “Files to Send” by clicking on each transaction 
needed.  You may send multiple transaction types in one submission.  Click on the 
Submit button.  All files are submitted as batch files, however, eligibility and claim status 
may also be submitted interactively (see instructions under section 6.4). 
 

 
Figure 47. Submission screen 
 
The following screen will appear if the submission is successful. 
 

 
Figure 48. Submission successful screen 
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If the submission fails the following screen appears prompting you to review the 
communication log to determine the cause. 
 

 
Figure 49. Submission unsuccessful screen 
 
 
7.2 Retrieving Files 
 
Select the type(s) of file(s) to retrieve under “Files to Receive” by clicking on each 
transaction needed.  You may request multiple transaction types in one submission.  
Click on the Submit button.  You will receive either the Submission Successful (see 
figure 48) or Submission Unsuccessful (see figure 49) message.  Once you receive the 
Submission Successful message, you will need to return to the Communication option on 
the main menu. 
 
The Claim Accept/Reject Report and Functional Acknowledgement Report should be 
retrieved after each submission of 837 transactions.  The Functional Acknowledgement 
will inform you of the HIPAA compliancy of the submission.  This report pertains to the 
HIPAA compliancy of the entire file.  In cases of rejection, it is the entire file that is 
rejected and the error must be corrected prior to submitting the file.  The Claim 
Accept/Reject Report is claim specific for errors that prevents EDS from processing the 
claim.  In this case, only the claim(s) listed on the report were rejected.  The remainder of 
the claims were accepted for processing. 
 
Note:  The Claim Accept/Reject Report and Functional Acknowledgement Report cannot 
be retrieved at the same time the claims are being submitted.  You must wait for the 
Successful Submission message after sending the claims before you retrieve the response 
reports. 
 
 
7.3 Resubmitting Claims or Files 
The software has a resubmission feature which allows you to resend file(s) or individual 
claims with or without making corrections.  Click on the Communication menu item and 
select Resubmission (see figure 46). 
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The Batch Resubmission screen will appear. 

 
Figure 50. Batch Resubmission screen 
 
Select the batch requiring resubmission or correction in the upper portion of the screen.  
The claims contained in the file will be displayed in the lower section of the screen.  At 
this point, you may select all the claims or deselect all the claims by using the buttons on 
the right hand side.  You may select only specific claims from a file to resubmit if 
necessary. 
 
Once the appropriate selection has been made, click on the Resubmit button if you want 
to submit the claims without making any changes.  If you need to make changes to the 
claims, click on the Copy button.  This will place the claim(s) in a ready status and may 
be accessed under the appropriate form type. 
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8 Archive Forms 
 
 
8.1 Create Archive Forms 
Claims which were previously submitted and in a finalized status may be archived.  This 
will assist with keeping claims organized. 
 
The software contains a prompt feature for archiving claims.  The default for the prompt 
is 30 days and may be changed by accessing Tools, Options, Retention, and then increase 
or decrease Archive Days.  The following message will appear upon start-up if there are 
claims with a submit date greater than the number of days listed on the Retention Tab.  
You may choose to archive at this time by selecting Yes.  If you choose No, the message 
will appear each time you start the software until such time as the claims are either 
archived or the number of days on the Retention Tab is changed. 
 

 
Figure 51. Archive Notification screen 
 
The following message will appear when Yes is clicked.  This is a reminder for those 
who installed the software on a server. 
 

 
Figure 52. Notification screen 
 
The following message will appear to give you a chance to cancel the process if you do 
not want the Incomplete claims to be deleted.  Click on No to cancel the process or Yes 
to Continue.  The number of days listed will correspond to the days set on the Retention 
Tab. 
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Figure 53. Notification screen 
 
The following screen will appear which allows you to select the transactions for archive.  
You may select all form types by clicking on Select All or you may select individual 
form types to archive.  You may increase or decrease the number of days by changing the 
number under Archive Forms at least __ days old.  The default corresponds to the number 
listed under Archive Days on the Retention Tab.  Click on OK to continue. 
 
The Archive file name is created using the date the forms are archived.  It is 
recommended you use the default archive file name and location, however, if you change 
it you will need to remember it for retrieval purposes. 
 

 
Figure 54. Archive Forms Selection screen 
 
The following message will appear when the archive process is complete. 
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Figure 55. Successful Archive screen 
 
 
If you wish to archive forms even though you have not been prompted, you may do so by 
clicking on Tools, Archive, and Create from the main menu as shown below.  Complete 
the archive by following the instructions listed above (see figures 52-55). 
 

 
Figure 56. Create Archive screen 
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8.2 Restore Archive Forms 
To restore archived forms, click on Tool, Archive, and Restore from the main menu. 
 

 
Figure 57. Restore Archive screen 
 
The following screen will appear.  If you know the name of the file you wish to archive, 
you may enter it or simply click Browse for the list of available files. 
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Figure 58. Restore Forms screen 
 
When Browse is selected, the following screen will appear with all available files.  Select 
the file containing the forms to be restored and then click on Open. 
 

 
Figure 59. File Selection screen 
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Figure 60. File Selection screen 
 
The following screen will display.  Click on Next, or Browse if the wrong file was 
selected. 
 

 
Figure 61. Restore Forms screen 
 
 
The following screen will display after Next is selected.  All form types included in the 
selected archive file will be displayed.  Select the form type needing to be restored and 
then click Next. 
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Figure 62. Form Type Selection screen 
 
The following screen will display showing the forms contained in the file.  You may 
restore all forms by clicking on Restore all forms or you may select individual forms by 
clicking on the form(s) needed.  You must hold down the Shift key if more than one, but 
not all, are needed.  Once the forms are selected, click on Finish. 
 

 
Figure 63. Restore Forms screen 
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The following will appear to indicate the restore has been completed. 
 

 
Figure 64. Successful Restore screen 
 



VERMONT TITLE XIX 
PROVIDER ELECTRONIC SOLUTIONS SOFTWARE 

USERS GUIDE 

 - 58 - 

9 Upgrades 
 
 
There are two methods for downloading an upgrade to the application.  The first method 
is the recommended method.  These procedures are only valid for updating when the PES 
Application is already installed. 
 
All Upgrades must be done consecutively.  If you need to apply more than one upgrade, 
you must use the Manual Download from the Web instructions (see Section 9.2). 
 
It is highly recommended that you save a backup copy of the database file prior to 
performing an upgrade.  The database file name is vtnewecs.mdb and can be located in 
the VTHIPAA folder.  Saving a backup copy of the database may prevent loss of any 
Lists you have created as well as claims previously submitted. 
 
9.1 Get Upgrades within the Application 
Step 1.  While in the PES Application, select the menu item Get Upgrades under Tools. 
 

 
Figure 65.  Get Upgrades screen 
 
Step 2.  When the following appears, you may exit the PES Application and apply the 
upgrade or apply the upgrade later.  If you choose to apply the upgrade later, you will 
begin with step 3. 
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Figure 66.  Information screen 
 
Step 3  (Applying the Upgrade).  Go to desktop and open the EDS PES folder.  The 
folder should appear similar to the following screen 
 

 
Figure 67.  Start up screen 
 
Step 4.  Double Click on the Upgrade icon.  This will begin the upgrade process. 
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The following message box appears and waits for you to make a selection. 
NOTE:  If you press enter instead of selecting Yes or No, the default is No.  Yes must be 
chosen in order to continue applying the upgrade. 
 

 
Figure 68.  Upgrade screen 
 
Step 5.  Click on ‘Yes’ 
 
 
Step 6.  You will be notified that there is only one upgrade and do you want to upgrade to 
2.##. Click on ‘Yes’.  The upgrade will begin  
 
 
Step 7.  When prompted, click on ‘Next’. 
 
 
Step 8.  When the upgrade has finished, you will be prompted to click on ‘Finish’. 
 
 
Step 9.  PES upgrades do not require a reboot.  Open the software and verify the version 
number.  The version number appears as the application is opening.  You may also verify 
the version number once the application is running by clicking on Help and then About. 

 
9.2 Manual Download from the web 
 
Step 1.  Go to web site at  www.vtmedicaid.com  
 
Step 2.  Click on Downloads. 
 
Step 3.  Click on Software link. 
 
Step 4.  In column labeled Name, click on 2.## upgrade (where ## is the desired upgrade 
version number). 
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The following box appears: 
 

 
Figure 69.  File Download screen 
 
Step 5.  Click on ‘Save’ button  NOTE: Upgrades are zipped files.  Do not open an 
upgrade. 
 
The following browser screen appears: 

 
Figure 70.  Browser screen 
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Step 6.  Use this browser to locate the subfolder ‘upgrades’ inside the folder the PES 
database is installed.  (If you accepted the default paths when you installed, the path is 
“C:\vthipaa\upgrades”.) 

 

Step 7.  Click on the ‘Save’ button. 
 

 
Figure 71.  Browser screen 
 
The following screen appears, showing the progress of the download. 
 

 
Figure 72.  Download screen 
 
Step 8.  Upon completion of the download, you may close out of the internet. 
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Step 9.  At this point you have the upgrade in place an may continue with “Applying the 
Upgrade” steps. 
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Applying the Upgrade 
 
Step 1.  Go to desktop and open the VT EDS Provider Electronic Solutions folder.  The 
folder should appear similar to the following screen. 
 

 
Figure 73.  Start up screen 
 
Step 2.  Double Click on the upgrade icon.  This will begin the upgrade process. 
 
The following message box appears and waits for you to make a selection. 
NOTE: If you press enter instead of selecting the Yes or No, the default is No.  The Yes 
must be chosen in order to continue with applying the upgrade. 
 

 
Figure 74.  Upgrade screen 
 
Step 3.  Click on ‘Yes’. 
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Step 4.  You will be notified that there is only one upgrade and do you want to upgrade to 
2.##.  Click on ‘Yes’.  The upgrade will begin  
 
Step 5.  When prompted, click on ‘Next’. 
 
Step 6.  When the upgrade has finished, you will be prompted to click on ‘Finish’. 
 
 
 
 
 
 


